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Rocky Mountain Philatelic Library Turns 15
A Tribute to The Past and The Future

By Peter W. F. Adgie

T

ake a schoolteacher, a chemist, a furniture dealer, a railway construction engineer, a
television reporter, a carpenter, and a professional librarian. Add a heavy dose of philatelic lore. Bingo! You have the
start of a collection of stamprelated materials that expands
and develops — and exceeds
all expectations.
Over a period of years,
starting with Saturday burrito
lunch meetings, these visionaries met in homes and basements; dreams were shared,
hopes raised (and felled); and
then came the call to action.
Don Beuthel, Bill Dunn,
Jack Willard, Jim Ozment, and
Roger Rydberg, signers of the
original Articles of Incorporation, with the added professional gift of Ellengail Beuthel,
launched their philatelic craft
into the Rocky Mountain world.
A corps of similarly dedicated
people soon joined them.
In August 1993, thanks to
the generosity of Dave Capra
in donating a meeting place on
South Peoria Street in Denver,
Colorado, the Rocky Mountain Philatelic Library was officially born. Financial gifts were
needed and found. Volunteers
stepped forward to serve as
sorters, greeters, and presenters. At first, three days a week,

then expansion to four and,
briefly seven! Disaster seemed
to strike when the original
donated space was needed for
other businesses, the library
temporarily moved into an adjacent smaller section later that
year. That space then was lost
and everything was placed into
storage. The search began for a
permanent home.
In May 1996, the building
at 2038 South Pontiac Way was
purchased with a mortgage and
underwent a major renovation
for several months. Steve Schweighofer, Jim Kilbane, Roger
Rocky Mountain Philatelic Library visitors are greeted with Rydberg (our first treasurer),
a congenial atmosphere as soon as they step through the Sergio Lugo, Bob Blatherwick
front door, above. The facility is well lit and attractively or- (taking over as treasurer), Ron
ganized. Among those who help ensure the library’s suc- Mitchell, and 20 or more othcess and value to researchers is Ellengail Beuthel, below, ers joined with those early viwho has provided her invaluable cataloguing skills. She is sionaries to create the highly
professional library.
now preparing an online version of RMPL’s catalogue.
The RMPL was officially
opened in its present site on
August 3, 1996. None of these
efforts would have been effective without the expertise of
Ellengail Beuthel, who voluntarily provided her dedicated
cataloguing and detailed reference skills. Unlike other philatelic libraries and research centers, RMPL has never paid its
increasing and concerned staff.
Virtually all of the philatelic
materials, along with the furnishings to display and house
them, have been donated.
Continued on Page 16
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Morality Cannot
Be Legislated

n a classic case of good intentions gone bad, New York Attorney General Andrew M. Cuomo has pressured a number of
U.S.-based Internet service providers (ISPs) into discontinuing or
severely curtailing their newsgroup services. (See Heather Sweeting’s article on Page 13.) At first this may seem of no importance
to philatelists. However, Cuomo’s actions have led to the loss of
access to philatelic-related groups.
The son of former New York
Governor Mario M. Cuomo
and brother of ABC newsman
Christopher (Chris) Cuomo
has fallen into the classic trap
of attempting to legislate morality or at least trying to force
it on others, in this case targeting Internet child pornography. He clearly has ignored
the lessons learned from The
Great Experiment — Prohibition — which not only failed
to stem American’s consumption of alcohol, but also led to
the growth of organized crime
Andew M. Cuomo
and its related vices, rum running, and the problems associated with bootleg alcohol produced without quality control oversight.
While Cuomo’s intentions are admirable, he has resorted to
shooting the messenger rather than seeking out and punishing
the individuals responsible for these heinous acts.
The most insidious aspect of Cuomo’s actions is that their cancerous growth could extend to other online services, including
YouTube, e-mail censorship, and the spread of Big Brotherism —
concepts usually associated with totalitarian nations.
His plans are ultimately doomed and may exacerbate the
problem by driving it underground. Cuomo apparently also
has overlooked the fact that the Mac Daddy of newsgroups —
usenet.com — is offering “unrestricted, anonymous access.”
Many similar fee-based services are making the same offer.
Although the ISPs were under no legal obligation to follow
Cuomo’s aims, they quickly fell, into lockstep. Along the way
they shed themselves of one of the services they provided without lowering their Internet service charges, meaning customers
are paying the same to get less. As Heather suggests, subscribers should let their ISPs know how displeased they are with the
curtailed services.

✒

Peter Martin
Hartford,
Connecticut
President’s

Peter Martin

My Message
StampShow 2008
and WU #30 Breakfast

Message

T

he American Philatelic Society’s StampShow 2008 will be August 14–17 in the three-year-old, 540,000-square-foot Connecticut Convention Center in Hartford, the capital of Connecticut. It is the largest meeting space of its kind between New York
City and Boston.
The Marriott Hartford Downtown, 100 Columbus Blvd., Hartford, CT 06106, is the show hotel and the site for the Writers Unit #30
breakfast on Sunday, August 17, at the usual 8:30 a.m. time. Tickets
are $27 each and may be obtained from the APS by calling 814-9333803 for reservations. The Marriott, which is interconnected to the
Convention Center, is located at Adriaen’s Landing, a new 30-acre
riverside complex that is surrounded by downtown Hartford.
Featured speaker will be David E. Failor, United States Postal
Service Executive Director for Stamp Services. His presentation
will be followed by a question and answer period.

Breakfast Treats

Attendees at the StampShow 2008 breakfast are in for some extra
treats beyond the normal activities. Chris Calle, a noted stamp designer for the USPS and other countries who resides in Connecticut, will again produce a special event cachet that will be stamped
and presented to all attendees. An added bonus will be given to
the first 50 members through the door — a copy of J. W. Scott’s
Metropolitan Philatelist, an 1890s monthly publication. There will
also be more than 20 philatelic literature door prizes.

WU #30 Board Meeting

The Writers Unit #30 Board will meet at 10 a.m., right after the
conclusion of the WU #30 breakfast. I’ll have a report in the next
Philatelic Communicator.

Writers Unit History

In last quarter’s column I mentioned that WU #30 Historian Steven
Rod and I are spearheading an effort to document the 40-year history of the unit. For those that missed it, I’m repeating our request
for photos, ephemera, articles or stories related to the history of the
organization. Please contact one of us via the addresses in the masthead. Photos of founders and officers are a particular need.

Position Opening

With the untimely death of Vice President East Barth Healey
we have an opening for a coordinator of the WU #30 outreach
program whereby we try to place articles in the nonphilatelic
press. If you have an interest in this position, please contact me
at pmartin2020@aol.com.

APS StampShow 2008
August 14 to 17
Hartford Convention Center

Please join us for our 73rd

Writers Unit Breakfast
8:30 a.m. Sunday, Aug.17

⦁ More than 20 philatelic literature door prizes
⦁ The first 50 guests will receive a copy of J. W. Scott's
“Metropolitan Philatelist,” his 1890s monthly publication

Tickets $22 until July 13 & $27 Thereafter
Call 814-933-3803 for Reservations

Speaker: David Failor

USPS Executive Director of Stamp Services

Promoting U.S. Stamp Collecting
David Failor …
was appointed USPS Executive Director of
Stamp Services in November 2002.
He is responsible for all aspects of the
stamp program, including design, manufacturing, and distribution of 35 billion
stamps per year.
He also serves as a member of the Coordinating Committee
for the Smithsonian Institution’s National Postal Museum.

✒
Third Quarter 2008
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George Griffenhagen’s
Wife Dies at 81

Short Takes

News & Commentary

J

ASDA Has New Director

Matthew Hansen is the ASDA’s new Executive Director. He has
more than 20 years experience with Harry Hansen Management,
a family-owned association management firm, with not-forprofit member-driven associations and trade shows. As in the
case of his two predecessors, Hansen is not a philatelist. He may
be reached at mvhansen@asdaonline.com or by phone at the
ASDA office, 516-759-7000.

Griffenhagen, Cartiers Leaving ATA

The American Topical Association has announced that Executive Director Ray Cartier and his wife would retire at the end
of his contract later this year. George B. Griffenhagen also has
announced that he will step down as editor of Topical Time, a
position he has held for 17 or 18 years, by 2009. A search committee is being appointed to seek replacements for the Cartiers and
Griffenhagen. The ATA’s board decreed color use in the journal,
necessitating computer facility for the editorial position.

87th PHLNDX Update

The 87th update to the PHLNDX project was issued to the APRL
in late May. This update includes more than 5,000 journal title
entries. This raises the database above 240,000 entries and puts
us on track to pass the quarter-million mark by year’s end. This
update includes a great deal of information from the immediate
period before World War II, as well as keeping up with current
publications. A file compiled by the late Fritz Billig in the 1930s,
before his hurried relocation from Vienna to the U.S. and housed
for many years in the Collectors Club library has been mined for
a large number of references to articles written in German beginning in the 1860s and continuing up to 1935. These entries deal
with a number of European countries.
— Gene Fricks

Steven Rod Absent Again

Steven J. Rod again was unable to submit his Rod of History column for this issue because of other commitments. He promises to
return in the fourth quarter issue of the Communicator.

oan Helen Houston Griffenhagen, 81, of Vienna, VA,
wife of WU #30 Secretary–
Treasurer George B. Griffenhagen died on June 23, two days
before their 62nd anniversary.
She was diagnosed with cancer
in July 2007 and transferred to
hospice care on May 6.
She was born in London,
England, on December 1,
1926. Joan was evacuated to
Northampton at the age of 12
on September 1, 1939, at the
outbreak of World War II to
avoid the heavy bombing of
London. She returned to London at the age of 16 where she
Joan Griffenhagen
was a receptionist at General
Dwight D. Eisenhower’s headquarters. In March 1944, she met
Griffenhagen who was preparing to land on June 6, 1944 during
the invasion of Normandy.
After the end of the war, she became engaged to George and
flew to New York City. The Griffenhagens were married June 21,
1946 in Hoboken, NJ. They lived for four years in Fresno and
Los Angeles, where she took several courses at the University of
Southern California while George was completing his education.
She was granted U.S. citizenship on July 14, 1950.
In December1950 they moved to northern Virginia where they
have lived ever since. For a dozen years she was a Chief Judge for
the Fairfax County Electoral Board. She became involved in several
bridge clubs, knitting for the family, and caring for her dogs. She
returned on several occasions to visit her family in London and
traveled with her husband to many countries around the world.
Her favorite trips were cruises that visited Tahiti and Hawaii.
Three children, Gary Griffenhagen, Gordon Griffenhagen, and
Barbara Commerce; seven grandchildren; and twin great-grandsons also survive her. Burial was at National Memorial Park, Falls
Church, VA. Donations in her name may be made to any animal
welfare organization.

✒

Journals Publication Resumed

Excelsior!, journal of the Empire State Postal History Society, and
Astrophile, journal of astrophilately for the Space Topic Study Group
of ATA and APS, have resumed publishing after long delays.
The semiannual Excelsior!, edited by David E. Williams of Louisville, KY, is two issues behind. Williams has indicated that the
journal will be back on track by September 2009, but needs articles.
Query him at davidewilliams@insightbb.com.
The bimonthly Astrophile, edited by Jim Roth of Colorado
Springs, CO, is four issues behind. He also needs articles. Query
him at spaceuniteditor@comcast.net,

✒
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Expert Help for Writers and Editors

harles J. Peterson, Writers Unit #30 past president, offers free
critiques of periodicals and books / manuscripts. Submit the
four most recent issues, including postage equivalent to four times
the first class mailing fee. Any unused amount will be returned.
Critiques can be expected in about 30 days. Inquire before sending
books and manuscripts, providing a brief description. Return time
will vary, depending on length and other commitments. Include a
SASE. Send to Peterson at P. O. Box 5559, Laurel, MD 20226. His
phone is 301-776-9822; e-mail cjp7777@aol.com.

✒

Thomas J. Alexander, Pandelis J. Drossos, Robert F. Dumaine, and Robin M. Startup

2008 Writers Unit #30 Hall of Fame Inductees

F

our new members of the Writers Unit #30 Hall of Fame have
been named. This year’s class — Thomas J. Alexander, the late
Pandelis J. Drossos, Robert F. Dumaine, and Robin M. Startup —
will be inducted at the Writers Unit breakfast in Hartford, CT on
August 17 during APS StampShow 2008.
The awards are presented in recognition of outstanding service and scholarship by authors, editors, and publishers. A plaque
on public display at the American Philatelic Research Library in
Bellefonte, PA, displays the names of the honorees.

Thomas J. Alexander

Thomas Jefferson Alexander is a retired lawyer and a resident

of Kansas City, Missouri, where he was born. He has contributed
more than 200 articles to the Chronicle of the United States Philatelic Classics Society, the American Philatelic Congress’ Congress Book, and the American Philatelist. His writing reveals his
philatelic research and reporting in such areas as postal markings, rates, and the printing of 19th century United States stamps.
He authored a landmark book recording a census of 1847 issue
covers as well as books describing exhibits at the Smithsonian’s
National Postal Museum. For more than 20 years he edited the
1851–1861 section of the Chronicle.
He is a trustee of the Philatelic Foundation and has served as
vice president, president, and board member of the U.S. Philatelic
Classics Society, where he has also chaired several committees.
He was honored with many honors from the Classics Society for
his research, writing, and service, including the Ashbrook, Chase,
and Brookman Cups, and the Cryer Award.
Alexander has also served on and chaired several committees
of the American Philatelic Society. Other honors bestowed on
him include the APS Luff Award for research, the Collectors Club
Lichtenstein Memorial Award, and the Smithsonian Philatelic
Achievement Award. He is past chairman of the National Postal
Museum’s Council of Philatelists’ research committee.
He continues his research work to this day with a major project to analyze recently discovered Post Office Department records
pertaining to the printing of U.S. stamps from 1847 to 1910.

Pandelis J. Drossos

Pandelis J. Drossos was born May 4, 1900, in Greece. He died
May 10, 1996, at the age of 96. Drossos had a worldwide reputation and was known as The Ambassador of Greek Philately. He
was the preëminent authority on the stamps and postal history
of Greece and the Ionian Islands. He was a world famous stamp
dealer, a prolific writer and an exhibitor of the stamps and postal
history of Greece. Drossos wrote his first philatelic article in 1920,
won his first international medal in 1930, and became a full-time
dealer in 1932. Throughout his career, he wrote extensively about
Greek and related stamps, and about Greek social and postal history. Aerophilately was one of his special interests and he was a
pioneer in the field.
Between 1946 and 1987, Drossos wrote 13 major research articles in the American Philatelic Congress’ Congress Book, the most
by any author and his five decades with at least one article ties the
APC record. His 1964 Congress Book article, “The Greek Military
Occupation Stamps of the Dodecanese,” received the APC Walter
R. McCoy Award for the best article in the 1964 volume.
He was a commissioner for Greece for many international
exhibitions from 1938 to 1970. Drossos was inducted into the
American Air Mail Society Aerophilatelic Hall of Fame in 1990
and the American Philatelic Society Hall of Fame in 1997.

Robert F. Dumaine

Robert F. Dumaine of Sugar Land, Texas, was born in New Orleans, Louisiana. He operates Sam Houston Philatelics in Houston and has been a professional stamp dealer and auctioneer since
1976. As the preëminent authority on duck and conservation
stamps, his encyclopedic knowledge of the subject has made him
the primary resource for duck stamp information. He regularly
reports discoveries of duck stamp varieties and errors.
Dumaine is the coauthor with Eric Jay Dolin of the gold medal
winning The Duck Stamp Story, which traces the history of the
federal duck stamp program and the stamps that have been issued. He was a duck stamp columnist for Linn’s Stamp News
Continued on Page 17
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PowerPoint Imaging for Digital References and Studies
By Francis Adams
Part V

5. Click Insert.
6. Move the image to the desired position on the slide. (Fig. 3)

I

f you are unable or do not wish to work with graphics programs to
modify images, Microsoft PowerPoint is an option provided you
already have basic images for your Digital Philatelic Study (DPS).
PowerPoint has several functions to enhance graphics, but are by
no means equivalent to those in fuller featured graphics programs.
However, they will be useful if this is the only method you have.
Note: The following instructions were developed using a Macintosh version of PowerPoint. Menus in the Windows version may
not be exactly the same, but the methods will be very similar.

Got Image?

Organization is always first. Put all images for your study into a single folder and make a back-up copy of the folder before touchng the
contents. When you’ve finished, you can begin working.
To modify an image, you must first get it onto a slide — it’s easy:
1.
2.
3.
4.

Click the mouse pointer in the Content box on the slide.
Choose Insert ▶ Picture ▶ ‘From File. (Fig. 1)
Navigate to the folder holding your images.
Select the desired image file. (Fig. 2)

Fig. 3 Position Image
Note: Use a background image only on the title slide.

Photoshop Challenged?

Let’s pull up the PowerPoint tool palette for image modification.
With this palette, we have the option to modify the chosen image
with commands directly from the palette. (The same commands can
be accessed from the main menu.) There are two identical images,
the top one is for reference and the bottom one will be modified.
Options shown here are directly related to modifying an image showing a philatelic item. Additional enhancements such as
drawing lines, geometric shapes, watermarking, etc. for display
purposes may be included in a future article. As to the sequence
of the options being presented, I’m going through the options
from top to bottom — there’s no other method to my madness.

The Formatting Palette

1. Select View ▶ Formatting Palette. (Fig. 4)

Fig. 1 Find Image

Fig. 4 Formatting Palette

Making an Image (Semi) Transparent
Fig. 2 Select Image
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1. Select the image.
2. Choose the Fill and Line ▶ Fill option.
3. Change the Transparency setting number. The image becomes more transparent with higher numbers. (Fig. 5)

Fig. 8 Line Type

Fig. 5 Transparency Setting

Outlining an Image
1. Select the image.
2. Choose the Fill and Line ▶ Line option.
3. Change the Line Color box (to blue in this case). (Fig. 6)

Changing Image Size
1. Select the image.
2. Select the Size option.
3. Change the Height or Width setting. (Fig. 9)

Fig. 6 Line Color

Fig. 9 Image Size

4. Change the Line Width box (to 3 pixels in this case). (Fig. 7)

Note: If Aspect Ratio is not enabled, height and width will not
change properly.

Rotating an Image by Degrees
1. Select the image.
2. Select the Size option.
3. Change the Degree of Rotation setting. (Fig. 10)

Brightness and Contrast Adjustments
1.
2.
3.
4.

Select the image.
Select the Picture ▶ Color option.
Change the Brightness setting to the desired level. (Fig. 11)
Change the Contrast setting to the desired level. (Fig. 12)
Note: Adjust Brightness first for the “lightness” of the image.
Adjusting Contrast will change the “blackness” setting and this
should be done only after adjusting Brightness to get the best

Fig. 7 Line Width
5. Change the ‘Line Type’ box (to dashed in this case). (Fig. 8)

results. These manipulations may adversely affect the image’s
true colors.
Continued on Page 8
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PowerPoint — Continued from Page 7

Fig. 13 Color Adjustment

Changing from Color to Grayscale
Fig. 10 Rotation by Degrees

1. Select the image.
2. Select the Image Control option.
3. Select the Grayscale option. The image discards the color
components and changes to grayscale. (Fig. 14)

Fig. 11 Brightness Setting
Fig. 14 Grayscale

Artistic Image Effects
1.
2.
3.
4.

Select the image.
Select the Special Effects option.
The Effects Gallery window appears.
Select the desired effect to be applied to the image. (Fig. 15)

Fig. 12 Contrast Setting

Color Adjustment
1.
2.
3.
4.
5.

8

Select the image.
Select the Color Adjustment option.
The Color Adjustment window appears,
Click on the Pre-sets to view the change. (Fig. 13)
If desired, choose and adjust individual colors as desired.

The Philatelic Communicator

Fig. 15. Image Effects Window

Applying a Shadow

1. Select the image.
2. Select the Special Effects ▶ Shadow option. (Fig. 16)

Fig. 18 Cropping an Image

Thanks

Fig. 16 Shadows
3. Choose the Shadow Type and Orientation. (Fig. 17)

My sincere thanks are extended to Alan Campbell and Richard
Maisel for their continuing support in reviewing drafts of these
articles and suggesting subjects for discussion.
Additional articles on digital philatelic references are: “Creating Digital References and Studies” (Philatelic Communicator, Second Quarter 2007), “Planning Digital References and
Studies” (Philatelic Communicator, Fourth Quarter 2007),
“Formatting Digital References and Studies” (Philatelic Communicator, First Quarter 2008), and “Preparing Content for
Digital References and Studies” (Philatelic Communicator,
Second Quarter 2008).

✒

September 25–27, 2009
Empire State Plaza, Albany
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S ociet

1.
2.
3.
4.

Select the image.
Select the Crop Tool button.
Lines and handles around the image appear.
Dragging lines to a desired position will change the portion of
the image displayed. (Fig. 18)

Conclusion

Newer versions of PowerPoint offer additional graphics tools, watermarks and image compression being two of the more important ones. Regardless of the level of the study, some image modification is required to complete a DPS and we hope the preceding
information was helpful for those collectors believing that only
professional graphic artists can work with images. That is not true
— anyone can do this.
We’ll look at developing layouts and master templates for our
DPS as our next area of interest. Watch for this article in the
fourth quarter issue of The Philatelic Communicator.
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Reviews

Print and Electronic

Books & Catalogues
Echoes of a Bygone Era

Camp Genter: Colorado Ghost Mail / Origins and Operations
of a 4th Class Post Office by John H. Willard and Sergio Lugo.
110 pages, 8½ × 11 inches, case or perfect bound. ©2008 Rocky
Mountain Philatelic Library. $40 postpaid for case bound, $30
for perfect bound from the publisher at 2038 S. Pontiac Way,
Denver, CO 80224.
his volume is the poster child for production of an exceptional
monograph with a high-end color copier/printer. It includes 42
illustrations, of which 32 are in color, and 27 letters and documents,
also in color. Camp Genter examines a little-known aspect of Colorado’s marble quarrying operations in the Crystal River Valley — the
contentious relationship between the irascible postmaster of a tiny
post office, the U.S. Post Office Department, and the Crystal River &
San Juan Railroad that provided service to the quarries and Railway
Mail Service (RMS) to the small communities along its route.
The CR & SJ connected the mining camps along the river to the
Denver & Rio Grande Western Railway connection at Carbondale.
The local carrier is notable for the fact that it transported marble
for the Tomb of the Unknown Soldier, including the largest block
of marble ever quarried. To learn more about the CR & SJ itself, see
the July 2003 issues of Model Railroader and Trains Magazine, both
of which failed to mention the RMS aspects of its service.
Edward Genter, who operated a small mountainside coal mining
operation, established Camp Genter in 1923 or1924. When the CR
& SJ began carrying mail from Carbondale south to Marble in January 1925, ending star route service — meaning patrons had to go
to Carbondale or Marble to retrieve their mail, Genter quickly lobbied for a post office at Camp Genter. The fourth class office opened
in March. Postmaster Genter died in late 1928 and the office was
closed in mid January 1930. Diminishing returns from the mines
and quarries led to the railroad’s abandonment in January 1943.
The story might have been untold if co-author John H. Willard
had not found a cache of correspondence — the Camp Genter Post
Office papers — in the basement of a building in Carbondale, where

T

Aeropostal History of Chile

Handbook of Aeropostal History of Chile 1916–2006 by Dr. Eduardo Madsen. ©2007 by the author, 698 pages, A4 format, soft
cover. 72€ including surface postage or 82€ by airmail worldwide from Dr. Eduardo Madsen, Albrecht-Duerer Strasse 15,
D-65195 Wiesbaden, Germany; e-mail: emadsen@t-online.de
he aeropostal history of Chile began on December 10, 1916,
when civil pilot David Fuentes was commissioned by the
postal administrator of Ancud, Chiloé Island, to carry mail on a
first flight from Ancud to Puerto Montt.
This handbook follows 80 Años de Historia Aeropostal en Chile

T
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his employer, the Public Service
Company of Colorado, had office space. The retired electrical
engineer made the discovery in
1958, but the story remained
unwritten until recently. While
few covers with the Camp
Genter postmark exist, the papers present a fascinating picture of Edward Genter’s frustrating efforts to ensure timely
mail delivery by the train he
scornfully dubbed The Marble
Flyer, and of USPOD and RMS
officials who had to deal with the prickly postmaster.
The first chapter of the book deals with the discovery of the
papers and the area’s ghost town heritage and discovery of the
Camp Genter papers, while the second chapter explores star route
service, the growth of mining and quarrying operations, and the
necessity of railway mail service. Both are lavishly illustrated with
historic images when the operations were active during the first
quarter of the 20th century and those taken by Willard in the
1950s. The next chapter explores the RMS, which is followed by
Genter’s efforts to get approval for a post office.
However, it is the fifth chapter — “The Bureaucratic Side of
Post Office Operations” — that explores Genter’s ongoing wrangle in a barrage of letters to the USPOD and the RMS that provides a true insight into operations of the short-lived post office.
The papers to and from the three parties, which are called out in
the text, are reproduced in an appendix. They are a testimonial
to the POD and RMS officials who responded to Genter’s acerbic,
sarcastic, and often flippant prose.
Most of his venom was directed at missed and irregular service by the railroad which interrupted the smooth flow of business correspondence and necessities for his community.
Typical of Genter’s writing is a letter sent on March 4, 1925,
opening day of his post office: “… I hope that it will in no way interfere with the inaugural ceremony in Washington. However, I am
sure that Cal (President Calvin Coolidge) would gladly postpone
the presidential event if he had knowledge of the conflicting dates.”
The final chapter explores Camp Genter and the CR & SJ’s demise.
My only complaint is that the pages and binding of the soft cover edition separate if the book is laid flat to an inside spread.
— Albert W. Starkweather
1919–1999, published in Spanish by the author in 2001. The new
book has the following chapters in both English and Spanish:
1. Mail dispatched on first, inaugural, special and occasional
flights 1916–2006; 2. Special and instructional hand stamps on letters and post cards forwarded on scheduled flights 1930–2006; 3.
Post card at reduced airmail surtax during Christmas and New Year
seasons 1932–1941; 4. Mail by airships Graf Zeppelin & Hindenburg 1930–1937; 5. Crashed aircraft mail 1928–1965; 6. 1928 and
1931 airmail stamps 1st day of issue; 7. Domestic and international
flight schedules 1927–1948; 8. Santiago to Europe airmail dispatches 1928–1941; 9. Megallanes to Europe airmail dispatches 1929–

1949; and 10. LC Postal rates and airmail surtaxes 1927–2003.
ters 6 to 10, and the original 113 quoted publications in the 80
Chapters 1 to 5 are from the previous book and were amended Años bibliography increased to 221 in the new handbook.
and supplemented mainly through contributions by readers of
The book is a monumental effort in covering the airmail of a
that book. Postal events are illustrated both with cachets and the small country.
corresponding covers. Later research allowed drawing up Chap— Ken Sanford

Moving Mail by Steamboat

U.S. Contract Mail Routes by Water (Star Routes 1824–1875) by
Hugh V. Feldman. 403 pages, 8½ × 11 inches, perfect bound.
©2008 Collectors Club of Chicago. $75 postpaid to the United
States (other countries add $10) from the Collectors Club of Chicago, c/o Duane Larson, P. O. Box 415, Park Forest, IL 60466.
his book is a feast for the eyes as it is attractively designed and
lavishly illustrated, mostly in color. Its concept is simplicity itself, tracing the contract routes state by state during expanded use
of steamboats before the Civil War and their decline thereafter as
railroads became the preferred method of moving the mail.
Each route is accompanied by a period map overlaid with a
line delineating its course, callouts for the ports of call, and often examples of covers carried on the route. Information includes
route number, contractor, cost, dates of service, frequency of service, and vessels used. Feldman’s arrangement of routes within the
states is perplexing. They are not arranged by location, waterway,
route number, beginning contract date, or contractor. This means
readers must rely on a gazetteer that omits names of waterways.
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Antarctic Expeditions Postcards

Postcards of Antarctic Expeditions: A Catalogue 1898–1958
(second edition) by Margery Wharton. 362 pages, 6½ × 9¾
inches, case bound. ©2007 by the author. Available for approximately $60 from the author 18 Millfield Rise, Bexhill-on-Sea,
East Sussex TN40 1QY, United Kingdom.
harton’s first edition was first published in 1998. The new
edition revises and updates it in a slightly larger format, as
well as containing nearly 100 more pages. The catalogue is for reference only and does not include value or scarcity data.
These picture post cards were issued to promote and celebrate
many important expeditions to Antarctica from the end of the
19th century up to the end of the 1958International Geophysical
Year. More recent cards and modern reprints of older ones are not
included. The cards are listed chronologically by expedition and
assigned catalogue reference numbers using a letter for the expedition followed by a number for each distinct post card.
The first entry is that for the cards pertaining to the Belgica expedition of 1897–1899 led by Adrien Victor de Gerlache. Each card is
illustrated and the description includes any caption printed on the
card followed by an English translation if the original is in another
language. Several sets of cards exist for the Belgica expedition and
the publishers are identified along with a useful description such as
undivided back for the address side. Five different sets of cards are
shown along with a number of privately issued cards.
The same treatment is used to describe post cards of the remaining expeditions of Drygalski, Nordenskjöld, Scott, Charcot, Shackleton, Amundsen, Shirase, Mawson, Byrd, Ellsworth, Hillary, and
many others. Each expedition’s cards are introduced with a short
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A route table and page location
for each state would be useful.
The gazetteer and map callouts raise another problem —
that of many spelling errors.
Among the problems in the
New York State section is the
misspelling of Ithaca as Ithica,
Lake Chautauqua as Chautauque, and misidentification of
Alexandria Bay as simply Alexandria. In most instances the
map beneath the callouts shows
the correct spellings.
For the price of the book one should expect better editing, as
the errors call into question validity of the information it contains.
Hopefully, the host of errors will be corrected in future editions,
as the book contains information unavailable anywhere else.
— Albert W. Starkweather
summary of the purpose of the
venture and its dates. The expeditions are grouped in three
categories: continental exploration 1893–1918, the whaling
period and early air exploration
1919–1942, and establishment
of permanent stations and their
scientific activity through the
IGY 1943–1958.
Although Wharton owns
many of the cards, she has relied on copies and scans from
others to fill in some gaps. The
beauty of the catalogue is not
only the black and white illustrations — the way many of the
cards were issued, but also the brief section of color reproductions.
As mentioned, the Belgica cards are identified with the letter A
and the listing proceeds to W for the 1947 Chilean Antarctic expedition. At the end of this main listing are several groups of cards that
commemorate more than one expedition. Handy reference tools at
the end of the book are an alphabetical listing of captions, and lists of
surnames and ships with cross references. A bibliography concludes
this wonderfully illustrated catalogue of cards that record famous
expeditions to the white continent. Now that picture post cards are
sanctioned for exhibiting at national shows in the United States, this
catalogue will be important for collectors of such material.
— Alan Warren
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New Advertising Postal Cards Handbook

United States Multiple Advertising and Discount Postal Cards
edited by Bill Falberg. 184 pages, 8½ × 11 inches, hardbound.
©2007 United Postal Stationery Society. $45 ($36 members),
P. O. Box 3982, Chester, VA 23831, www.upss.org.
avid G. Nussmann, Charles A. Fricke, and George C. Norton
originally published this comprehensive handbook in 1982
as limited photocopies. The authors gave their permission to the
United Postal Stationery Society to update this important work to
expand on the many and varied usages of these cards.
Multiple advertising postal cards contained advertisements
from more than one business while discount postal cards were
sold to the public for less than what the post office charged. Although these definitions suggest two distinct collecting possibilities, the relationship between the two is intertwined and to collect one area is impossible. Throughout the book are examples
of discount cards containing multiple advertising. Falberg even
goes so far as to warn that to ignore one aspect would cloud the
understanding of the historical context of a particular card and
the business that was advertised on the card.
A total 94 card types by 35 different businesses are examined.
The period covered by this book spans the years 1873 with the
introduction of G. W. Simmons Oak Hall, Boston cards and ending with the Allentown cards in 1913. The comprehensive listings
detail all the known varieties; most are illustrated.
This handbook goes beyond the standard catalogue by establishing the relationship between the cards and card manufacturers, and
explains who the businesses were and the products that they were
selling at the time as shown in extensive advertiser collateral material. The material is classified as either company collateral, where advertising appears on multiple advertising cards, or format collateral,
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Finnish Catalogue Updated

LAPE Special Stamp Catalogue of Finland. 784 pages, 6¾ × 9¾
inches, perfect bound, stiff covers, color illustrations. ©2007
Philatelic Service of Finland, Turku, Finland. $85 plus postage from Jay Smith & Associates, P. O, Box 650, Snow Camp
NC 27349.
his specialized catalog of Finland is not published annually,
but it remains an important resource for collectors of this
country. The previous edition in 2004 was smaller in trim size
and contained fewer pages. The larger size improves utility. The
text still is mostly Finnish and Swedish, although each stamp subject is identified in English as well. Parts of the introductory material are also in all three languages.
Following a short description of prestamp mail, the early cancellations are valued for the straight line, boxed, single, and double-ring postmarks, and then 19th century stamped covers are
listed for both domestic and foreign destinations.
The stamp listings begin with the oval issues and the serpentine roulettes. The 19th century stamps are dealt with in some
detail in all three languages. The stamp listing proceeds chronologically with significant descriptions of the major definitive series that touch on paper, watermarks, perforations, sheet layout,
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which are advertising cards of
single firms whose card format
resembles the multiple advertising card formats. The book
claims that the cards shown are
typical for multiple advertising
cards yet complement the presentation of these cards.
Handbooks are only useful
if the material is available to
make it a comprehensive resource. Falberg went to great
lengths to solicit material in
private collections for this
book. The illustrations picture the entire card in crisp black and
white scans. The catalogue format is concise and easy to understand with an outline in the beginning of the book tabulating the
cards to be shown and conveniently called a table of contents.
Falberg introduces the MA prefix for classifying multiple advertising and discount postal cards in the handbook with one-tier
(letter) or two-tier (letter and number) identification for varieties.
Each variety is also cross-referenced to Scott and UPSS catalogue
numbers for the postal card on which the advertising appears.
Commentary on dates of cards and historical perspective serve to
place the cards in the context of the time period of their use.
One drawback of this excellent work is its size and binding,
which may hinder its use at a stamp show. A bound book of this
type does not open flat and its large size makes it bulky to handle.
However this in no way detracts from its value as an important
contribution to this area of postal card collecting.
— Al Carroccia

gum, etc. Values are shown for
mint, used, on cover, and first
day covers. Issues through
2007 are included.
Following the stamp listings
are personal stamps, official
yearbooks and maximum cards,
bus parcel stamps, field post,
East Karelia, North Ingermanland, Aunus, stamp booklets including slot machine types, Frama labels for both Finland and
Åland, Christmas seals, shipping company stamps, Helsinki
and Tampere local post, railway
stamps, revenues, perfins, postal stationery, rate tables (1875-2000),
and commemorative cancels from 1920 to 1979.
The stamps of Åland (1984–2007) are then listed including
the booklets, official year sets and maximum cards. All items are
shown in color. The LAPE catalogs have been published for more
than 70 years and this latest one will serve the collector of Finland
and related areas extremely well.
— Alan Warren

Correspondence from On High

A Catalog of Himalayan Mountaineering Correspondence by
Armand E. Singer and Robert F. Gould. 126 pages, 8½ × 11
inches, perfect bound, ©2007 George Alevizos, Topanga CA.
Approximately $50 plus postage from George Alevizos, P. O.
Box 1408, Topanga CA 90290; www.tibetanpost.com.
his is the second edition of a book originally published in
2002. It expands that listing and incorporates corrections to
the earlier version. Rather than including a formal bibliography,
the authors describe major sources for background information
in a section following the preface, titled “Assignments, Responsibilities, and General Acknowledgments.” This section defines the
contribution of each author based on the strengths of their collections. A rarity scale, ranging from U for unique to C for common,
is assigned to each entry.
The catalogue begins with a brief list of pioneer Himalayan
climbers whose correspondence or autographs may be found.
This was well before the introduction of souvenir covers with
special cancels or cachets marking the events. The catalogue
numbers are assigned chronologically to postal and related items
for each climb, beginning with the 1921 survey party expedition.
Black and white and occasional color, illustrations add greatly to
the sense of history revealed by the entries that include photos,
letters, souvenir cards, labels, and other items.
The first major listing is for the Mount Everest expeditions, beginning in the 1920s and highlighted with the famous 1924 British ex-
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Swedish Postmuseum Yearbooks

Postryttaren 2006, Postryttaren 2007, Postryttaren 2008 edited
by Jan Billgren. 220, 160, and 168 pages respectively, 6½ x 9¾
inches, case bound, in Swedish with English summaries. Annual yearbooks published by the Postmuseum, Box 2002, 10311
Stockholm, Sweden. Issued to the Friends of the Postmuseum
for an annual fee of approximately $35.
ust as collectors look forward each year to the American Philatelic Congress books, many also eagerly await the yearbooks of the
Swedish Postal Museum. Both annual publications reveal a diversity
of topics that are quite engaging. The three latest editions of Postryttaren are the 56th, 57th, and 58th. The title is Swedish for post rider.
Volume 56, 2006 — This year marked the centenary of the Swedish
Post Museum’s opening in 1906. Editor Jan Billgren gives a brief
profile of each of the museum’s nine directors over the years. Erik
Hamberg summarizes some of the major stamp donations made to
the museum during this time. Other authors describe some of the
major items in the museum’s collections such as photographs, postal history objects, clothing worn by postal employees, and some of
the rare stamps.
Another summary describes some of the outstanding exhibitions held at the museum during the previous century. 2006 was
the 150th anniversary of the issuance of Sweden’s black local stamps
for use on mail within Stockholm and the surrounding area. Mats
Ingers describes the stamps’ production and postal history.
Volume 57, 2007 — The lead article by Robert Mattson and Björn
Sylwan details new acquisitions to the museum’s collections including a 22-pound book of proofs from the Post Office Stamp Department. The proofs are for many of Sweden’s early issues. One unusual
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pedition. The additional listings
in this section cover the Everest
expeditions and attempts into
the 1980s, and include stamps
pertaining to Everest issued by
several countries up to 2002.
The next section covers Himalayan expeditions to peaks
other than Everest, from 1929 to
1986, largely Gould’s contribution to the book. Related stamp
issues are listed through 1996.
In both listings, specific expeditions are found in the chronological sequence by year. This
revised edition includes an alphabetical index of mountain names
with catalogue year and item numbers associated with them. This
index also shows the height of the named peaks in meters and feet.
The book lacks a proper title page to indicate publisher, and
place and date of publication. The insertion of several illustrations with page numbers such as 105A alters the subsequent page
numbering from the usual odd numbers on the right hand pages.
This book was one of the last contributions of the late Armand
Singer to philatelic literature, and stands as a wonderful record of
his Mount Everest collecting interests.
— Alan Warren
addition pertains to the 1920 special airmail stamps consisting of
Swedish officials overprinted Luftpost. The latest acquisition is a
hitherto unknown trial overprint using the word Flygpost instead.
Fredrik Ydell describes the handling of mail by airship to Sweden and Finland during the period 1919–1930. The Zeppelin mails
include the 1930 LZ127 Helsinki trip for which Finland issued the
1930 overprint to be used for that flight. Other articles in the 2007
book discuss the letter-writing of Carl Linnaeus, the abuse of the
free letter privilege during the 17th and early 18th centuries, the
story of Heinrich Lichtenstein who discovered the 3-skilling yellow
error stamp, and a profile of Swedish engrave Majvor Franzén who
produced nearly a 100 Swedish stamps between 1967 and 1987.
Volume 58, 2008 — This edition begins with Thorsten Sandberg’s
appreciation of the late engraver Czeslaw Slania, followed by editor Jan Billgren’s review of the conformance by Nordic countries
to the uniform stamp colors recommended by the Universal Postal Union. Other topics covered in this volume include the collecting of picture postcards, postmarks on early Swedish stamps,
varieties of the Oscar II copperplate recess issues, 20th century
Saturday and Sunday mail delivery, and Swedish philatelic periodicals that began publication during the period 1920–1949.
Illustrations in these three volumes are in color and have both
Swedish and English captions. Brief English language summaries
of the articles appear immediately after each article. Each volume
ends with highlights of events at the museum during the preceding calendar year. These three issues of Postryttaren continue the
fine tradition of scholarly articles on both classic and modern
philately of Sweden.
— Alan Warren
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Electronic Media
Pop Culture: Philately on YouTube

Y

ouTube (www.youtube.com) is one of the most popular sites
on the Internet. Its sole purpose is to allow users from all over
the world to upload their personal digital video content and share
it globally. Anyone with a digital video recorder can edit their material, sign up for an account, and voilà, an audience of millions
might see their digital efforts.
YouTube is not just for teenagers to share videos of themselves
doing silly things or those wanting to show their cat dressed in costumes. You can view videos on YouTube that teach you to do just
about anything from speaking Swahili, learning about Rembrandt
paintings, or what happens when you combine Mentos candy with
Diet Coke. In other words, just about any subject can and has been
featured in a video. Those who want to watch videos will need a fast
digital Internet connection, such as a cable modem or DSL. Watching videos on a dial up connection is futile and time consuming.
A philatelist can do many things with YouTube. There are numerous clips from people who have digitized their collections; eBay
sellers can embed videos. JVC, and others, have introduced YouTube dedicated camcorders. Videos can be set to music. Anyone
with a laptop can download a video, or download it to an mp3 video
player, get an audio–visual cable and hook it into a TV to display it
at a club meeting. Try searching on the words philately, stamp collecting, postage stamps, or stamp exhibits to find some neat videos.
Some videos are educational, offering informational aid to those
who may not have a skilled expert around to show them the basics
of philately. For example, Kenmore Stamp Company has a video
about how to detect watermarks on stamps, www.youtube.com/
watch?v=rkGjeP_XSdQ It also has videos on how to mount and
hinge stamps and the use a perforation gauge.
Some videos have better images than others. Some well done
Romanian philatelic images are set to folk music at www.youtube.

com/watch?v=tRGhXIDZzgY&feature=related. Personally, I
enjoyed the stamp images more than the music. Images found in
a medical stamps video were not nearly as high quality, www.youtube.com/watch?v=yEqv4L28HNk&feature=related.
Some of the video editing in these exhibits is crudely done, and
others are well done with smooth transitions between images.
One of the better visual exhibits is the Rarest Stamps of Libya
1951, www.youtube.com/watch?v=QuT3knzwrN0, posted by
eBay seller Philatelicum, who has created many videos. Philatelicum
also has an interesting topical video featuring World Wildlife Stamps
of Libya and topical postcards of animals with matching stamps.
The beauty of YouTube is that the content constantly changes. If
you look at all the exhibits today, there will be more in two weeks.
If you really want to be entertained, try Classical Gas with Stamps,
www.youtube.com/watch?v=qEMmbnhmTak&feature=
related. In three minutes hundreds of images change with the musical beat, including some gorgeous French art stamps.
— Heather Sweeting

The Demise of Newsgroup / Usenet Services

S

everal Internet service providers across the country, including Time Warner, Verizon, and Sprint — under pressure from
New York Attorney General Andrew M. Cuomo — recently chose
to discontinue their newsgroup services or portions thereof. Cuomo’s stated goal was to eliminate the free exhange of child pornography, although his action has produced unexpected results.
For those who have never used these groups, they are a portion of the Usenet (user network — www.usenet.com), an informational message board, where people all over the world can exchange queries (posts) and have online discussions. These groups
are the predecessors to more recent Web logs (blogs) and message boards, which have proliferated. If you’d like a more in depth
explanation, search on the Internet for Usenet newsgroup.
There are several stamp collecting-related groups including
alt.rec.collectingstamps.discuss and alt.rec.collecting.
stamps.marketplace, where a person with a Usenet Newsgroup
reader or Microsoft Oulook can read and swap information. Sadly, the action by the Internet providers has terminated this service.
If you have been an avid participant in these groups, it may no

longer be possible to visit your favorites unless you can find a free
news server or pay for a subscription. Ask your Internet service
provider if it will give you a discount since it is no longer providing the same level of service. You may not get one, but at least the
provider will know that its customers are unhappy, What’s next?
Limiting the number of e-mails you can send or reducing your
bandwidth so you can view fewer pages?
There is a way for those whose newsgroup service was discontinued to still participate in these discussions. Visit Google Groups
at http://groups.google.com and search on the word stamps.
The groups I mentioned will be listed in the list of groups. Then
click on the group you would like to view. Some of the more recent discussion topics were: Danish philatelic translation, Slania
engraved test booklets, imperforate St. Thomas souvenir sheets,
and identifying an unknown overprint on French stamps. Have
a question about a particular item? Odds are good that if you can
post a picture of your item and ask your question in the group
that someone in the world can answer it.
— Heather Sweeting

Journals & Newsletters
German Postal Specialist Entices Reader

Published monthly by the German Philatelic Society, 5½ × 8½
inches, saddle stitched, 50 pages, color. Editor James W. Graue,
11911 E. Connor Road, Valleyford, WA 99036; www.gps.nu.
fter reading one issue of the German Postal Specialist, the
reader is drawn into history, as it is the key to understanding the convoluted circles of this intriguing area. Collecting
Germany means sorting out the different governments, the
World War eras and the period between, the post war period,
East and West Germany, and the current reunited Germany. Of
course one also can collect German colonies or offices abroad.
When you consider postal history, the options are infinite.
With such a broad area to cover, an editor faces a daunting task
of soliciting material to cover all areas and quenching reader interests. The German Postal Specialist comes close to accomplishing this.
Feature articles in one copy covered topics from the early part of the
20th century to the post World War II period. Graue surveyed Third
Reich philately, disclosing the flexibility of this popular area. Even
though the Third Reich period was brief, he argues that collecting
opportunities are abundant — particularly in postal history with
the many uses for these stamps and a variety of rates.
Another article examined the World War I Jutland naval battle
through covers from the German ships that were sunk. The covers
helped balance the article written by John R. Norris and kept the
philatelic theme from being overtaken by too much history. Other
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Briefly Noted

The China Clipper is published bimonthly the China Stamp Society, Inc. 8½ × 11 inches, saddle stitched, 30 pages. Editor Ralph
Weil; www.chinastampsociety.org. With the Olympics being
held in Beijing this August the Chinese have rolled out the red
carpet to showcase to the world it is worthy of being the host. The
China Stamp Society also jumped on the Olympics bandwagon
to showcase Chinese philately through its China Clipper. Each
issue was chock full of society and chapter news from throughout
the world. There are reviews of shows and awards along with details on the society library and ongoing efforts to archive records.
Articles are specialized in nature with clear illustrations in
black and white. The subject matter primarily is from the early classic period and well written. However, the single-column
layout not only wastes space, but is also tiresome on the reader’s
eyes. The center of the September 2007 issue contained an excellent map of the postal districts in Shanghai, but no notes or commentary to explain its significance.
The Journal of the New Jersey Postal History Society
is published quarterly by the New Jersey Postal History Society.
8½ × 11 inches, saddle stitched, 58 pages. Editor Robert G. Rose;
www.members.aol.com:/njpostalhistory/phsindex.htm.
Rates, cancels, and markings are the foundation of postal history
and understanding its significance, especially from an historical
perspective. Postal history, particularly at local level study of individual active and dead postoffices and their postmasters, provide
a ripe opportunity for research. This is the theme of many articles.

articles were written in the same
manner. Unfortunately all of the
feature articles were highly specialized and no general articles
or essays were included. Even
the single-page short essays
were specialized. It would have
been nice to see a refresher column written for the general collector or a synopsis of rates or
issues. A new issues column introduced the latest stamps coming out of Germany. An article
on the effects of PVC film on
classic stamps was insightful.
Overall, the German Postal
Specialist is a wonderful, compact source of information for the specialist. It is printed in color on
coated paper. The illustrations are crisp, particularly photographs.
The scans of covers are detailed and jump out. The layout makes it
easy for the reader to follow with advertisements strategically placed
at the beginning and end of the issue or after articles. Society news is
abundant as is news from specialty and chapter clubs.
— Alfred Carroccia

Most are rich in providing information about New Jersey postoffices,
especially the postmasters who operated them and their locations.
Articles are profusely illustrated with excellent scans of covers and
maps showing locations. These articles illustrate the need to document postoffice history, especially those that were discontinued.
Other articles examined the express companies in New Jersey prior
to the release of the first adhesives in 1847 and the post roads these
companies used. An interesting item was the philatelic shorts, a
one-paragraph synopsis of a cover or other related philatelic items.
A project to classify New Jersey manuscript cancels showing
earliest and latest uses on covers in a database is also reported.
This is an evolving project. There were a few articles on stamps
including a concise article on New Jersey perfins and a detailed
study of the 12 cent 1851 issue in New Jersey. One article on present day collecting examined New Jersey sprayed on markings.
Each issue contained updated news on society happenings. The
magazine layout was balanced between text and illustrations and
each issue was three-hole punched for easy filing.
— Alfred Carroccia
Material for reviews may be sent to the editor. Reviews are also
welcomed from others. Reviews should be concise and stress
those aspects that are helpful examples (positive or negative)
for other authors, editors, and publishers. Review requests from
those having an interest in the item, such as publishers and distributors, must include a copy of the publication.
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A Friendly Meeting Place
Scribblings editor Ron Hill, far left, confers with George Snyder in the stacks.
The Mexico-Latin American Study Group, above, is one of a number of groups
taking advantage of the meeting facilities.

RMPL — Continued from Cover
At the same time major efforts to achieve nonprofit certification
were made, thus allowing donors to receive a tax exemption.
The passing of Joe Weinman and Bill Dunn and the illness
of Jack Willard, reminds us that the other creators of the library
remain evident and as supportive as ever. Vi Weinman and Sue
Dunn, the latter a volunteer who also maintains our flower garden as a memorial to Bill, are evidence that the leadership is
also a family affair. The stories of the past resound in all the developments: stamp clubs meeting at the library, major and not
so major collections of stamps and literature, catalogues and
miscellany; thousands of volumes available for research; and a
growing publications and publicity program initiated by Ron
Mitchell and Sergio Lugo, along with the outstanding library
newsletter, Scribblings, originated by Don Beuthel, and printed
and published by Roger Rydberg, later expanded by Ron Mitchell and now edited by Ron Hill.
Each one of these remarkable persons would merit an essay on
their own — the creation of our logo by Bill Dunn’s son; the donation of shelves, tables and furnishings by various members; the
one-time member of Jack Willard’s Boy Scout troop who improved
the plumbing; the purchase of the carpet by square foot donations
of many; the labor of renovating the building by Steve Schweighofer and Cliff Lushbough with the help of dozens of others; the
recruiting of philatelic donations by Joe Weinman and other innovators; the vision to purchase a high quality color printer/copy
machine making the newsletter, monographs and, now, even a new
hard-cover book, assembled with Ron Mitchell’s computer skills;
our amazing map collection supervised by Bob Brown; and work
by Sergio Lugo and his crew in the preparation for sale of the multitude of stamps donated to the library over the years.
Fiscal responsibility along with the amazing generosity of the library’s members made it possible to pay off the mortgage in 2003.
Today, to the countless hours of labor by the Board of Direc-
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tors under the leadership, first of Don Beuthel and now Ron
Mitchell, are added the services of more than 30 volunteers who
put in weekly shifts to keep the library open and the impressive
venture it has become. Numerous stamp clubs meet at the library
including the Scandinavian Collectors Club local chapter, whose
national library is also maintained under the RMPL roof.
Thanks to Ellengail Beuthel our cataloguing will soon be going
online — the first regional philatelic library to do so — with our
books open to the world. New clubs are becoming viable thanks
to the RMPL resource, the newest being the Machin Study Group
that meets monthly at the RMPL.
Even more significantly, children and youth are being served and
encouraged, thanks to many leaders, with efforts by Don Beuthel
and George Wright from the very beginning and today led by Don
Dhonau as coordinator of the monthly Youth Club with contacts
with schools and youth organizations. RMPL is also very evident
at stamp shows, with auctions and displays at the Rocky Mountain
Stamp Show and other local shows such as Apex and Cherpex.
Rightly impressed with the present results of their dreams, the
present leaders are acutely aware that the true evidence of all their
efforts depends on the future. And the future is far from bleak: New
members — now numbering well over 450 — assist with financing
and publicity. The Board of Directors is discussing plans for future
expansion and the possible need for a paid coordinator. All of these
point to a vibrant Rocky Mountain Philatelic Library that confidently looks to many future decades and its silver anniversary in 2018.
Y’all come! We’ll be there!
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About the Author
The retired Rev. Peter W. F. Adgie commenced stamp collecting
in the UK at age 10 (more than 65 years ago). He has been a
member of several stamp clubs in Great Britain, New Zealand,
and Colorado and has been a member of the Rocky Mountain
Philatelic Library for 10 years. Currently he specializes in Canal
Zone, New Zealand specialties, and U.S. uncut press sheets.

2007 Chapter Activities Committee Newsletter Competition Awards

A

PS Chapter Activities Committee 2007 Newsletter Competition winning publications and their editors are:

Danielson, Wichita, KS

Vermeil

Stamping About Town, Charlottesville Stamp Club, William W.
Sihler, Keswick, VA
Vermeil
The Fort Orange Philatelist, Fort Orange Stamp Club, Maris
Driftwood, Long Beach Stamp Club, Lloyd Baumann,
Tirums, Albany, NY
Huntington Beach, CA
Milwaukee Philatelist, Milwaukee Philatelic Society, Inc., Carol
Silver–Bronze
Schutta, Milwaukee, WI
Thames Stamp Club Newsletter, Thames Stamp Club, Tony Bruno, Stamping Around, Mountain Home Area Stamp Club, Lorraine
East Lyme, CT
Burdick, Mountain Home, AR
Graebner Gazette, Robert C. Graebner Chapter AFDCS, Rollin F.
Berger, Jr., Clifton, VA
Saugeen Stamp Club Bulletin, Saugeen Stamp Club, Ralph
Gold
Wyndham, Lucknow, ON, Canada
PhilaNews, Brookfield Philatelic Society, Alan Vale, Danbury, CT
Silver
Prairie Stamp Views, Champaign-Urbana Stamp Club, Ed
Calgary Philatelist, Calgary Philatelic Society, Dale Speirs,
Dueppen, Mahomet, IL
Calgary, AB, Canada
Chicago Philatelic Society Bulletin, Chicago Philatelic Society,
The Chattanooga Stamp Chronicle, Chattanooga Stamp Club,
Randall Sherman, Chicago, IL
Willis Monk, Old Fort, TN
The Hamilton Hinge, Hamilton Township Philatelic Society, John
Huntsville Philatelic Club Newsletter, Huntsville Philatelic Club,
S. Sack, Hamilton, NJ
Arthur J. Cole, Huntsville, AL
Knoxville Philatelic Society News, Knoxville Philatelic Society,
South Miami Stamp Club Newsletter, South Miami Stamp Club,
Thomas W. Broadhead, Knoxville, TN
Enrique Setaro, Miami, FL
The Shoe Box, Lakeshore Stamp Club, Inc., Raymond W. Ireson,
Silver–Bronze
Roxboro, PQ, Canada
Hollywood
Philatelist, Hollywood Stamp Club, Enrique Setaro,
MSC Monthly Bulletin, Merchantville Stamp Club, Stephanos S.
Miami, FL
Hadjiyannis, Cherry Hill NJ
Stamping Around, Mid-Cities Stamp Club, Peter Elias, Plano, TX West Suburban Stamp Club Newsletter, West Suburban Stamp
Club, Sandra Strzalkowski, Redford, MI
The Postmaster, New Haven Philatelic Society, Campbell
Wilkinsburg Stamp Club News, Wilkinsburg Stamp Club,
Buchanan, Branford, CT
William A Badali, Pittsburgh, PA
NEPPS Philatelic Inquirer, Northeast Pennsylvania Philatelic
Applications for the 2008 competition are available from Jane
Society, Rufus Wilson, Dalton, PA
Wichita Stamp Club Newsletter, Wichita Stamp Club, Neal E.
King Fohn, 10325 Little Sugar Creek, Converse, TX 78109.

Class I: Single Page

Class II: Multi-Page

✒

Hall of Fame — Continued from Page 5
for 18 years, a columnist for Stamp Collector, and a contributor to
Duck Stamp and Print Forum and Duck Tracks, the NDSCS journal. In all, he has more than 250 published articles to his credit.
He is the publisher of The Duck Report and is a regular contributor to that publication. He was also the force behind the duck
stamp listings in the Scott Specialized Catalogue and has been an
expert contributor ever since. He publishes eight annual auction
catalogues. In total, he has published more than 70 public auction
and 225 mail auction catalogs. He also publishes and edits the Duck
Stamp and Print Catalogue, a biennial retail price catalogue.
Dumaine is the founder, of the National Duck Stamp Collectors Society, a former American Stamp Dealers Association board
member and a Federal Duck Stamp Contest judge.

Robin M. Startup

The name of Robin M. Startup of Masterton, New Zealand, is synonymous with New Zealand postal history. The New Zealand native
was first noticed by many outside of that country when he was the
driving force behind the launch of the Postal History Society of New
Zealand in the early 1960s. He was the founder–editor of its journal,

The Mail Coach, and contributes articles regularly.
He has contributed to or writen more than 60 books and has
written well over 1,000 articles on various subjects. Although his
studies are generally limited to New Zealand postal history, he has
published in the journals of a number of other countries, particularly the United Kingdom and the United States.
As historian for New Zealand Post, he has access to many records
that others might not know to exist. In this capacity, he is generous in offering his help to researchers who may wish to contact him
looking for answers to questions on New Zealand postal history.
His writing and studies led to his being awarded the rare FIP
Medal for Research in 2000. More recently, he was selected to
sign the Roll of Distinguished Philatelists. Over his many years in
philately, he has served in virtually every administrative capacity
in the various philatelic organizations in New Zealand.
Startup’s work frequently draws on his personal collection of
postal history and markings. His current efforts involve a project
that will cover the Colonial Post from 1840 to 1860, which is a
major challenge since two fires destroyed most of the critical records. Nevertheless, he has been able to examine and copy some
4,500 sheets of documents in the National Archives, containing a
total of 10,000 document notes or references.

✒
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Napex 2008 Literature Awards
W

inners of literature awards at Napex 2008 on June 6–8 have
been announced. Judges were Alan Warren, chair; Michael
D. Dixon; and John Hotchner.

Grand Award and Gold

U.S. Contract Mail Routes by Water (Star Routes 1824–1875),
Collectors Club of Chicago, Hugh V. Feldman, author

Noncompetitive Exhibits

Vatican Notes Volume 56, Vatican Philatelic Society, Daniel A.
Piazza, editor
EnRoute Volume 15, Smithsonian National Postal Museum
The William H. Gross Collection: United States Classics, 1847–
1869, William H. Gross and the Collectors Club of New York
Guide to Stamp Collecting, HarperCollins Publishers, Janet
Klug, author
The Sovereign Collection: Postage Stamps of the British
Commonwealth and Western Europe, Smithsonian National
Postal Musuem

Handbooks and Special Studies
Gold

The Turbulent Decade: Georgia’s Post Offices, 1860–1869, Francis
J. Crown, Jr., author
Index to Congress Books No. 1–No. 72 (1935–2006), American
Philatelic Congress, David L. Herendeen, author; John Kevin
Doyle, editor
The Liberty Series, American Philatelic Society, Ken Lawrence,
C. David Eeles, and Anthony S. Wawrukiewicz, authors
Definitive Postage Stamps of Canada, 1953–2005: An Analytical
Approach, Joseph Monteiro, author
A Short History of the Rossica Society, 1929–1968, Rossica Society
of Russian Philately, David M. Skipton, author
Japanese Post Offices Using the Maruichi Postmark, 1888–1909
(CD-ROM), Charles A. L. Swenson, author
The Congress Book 2007, American Philatelic Congress, Ken
Trettin, editor
Revenue Stamps of Norway and Related Non-Fiscal Issues, Bjørn
Kristian Wang, author
U.S. Three Cent 1851 Essays for Postage Stamps (and Related Topics)
(CD-ROM), U.S. Philatelic Classics Society, Roy Weber, author
Camp Genter: Colorado Ghost Town Mail, Rocky Mountain
Philatelic Library, John H. Willard and Sergio Lugo, authors
2008 Durland Standard Plate Number Catalog, United States Stamp
Society, Len Piszkiewicz, compiler; W. Wallace Cleland, editor

Vermeil

Women on Stamps Volume 5, American Topical Association
(ATA), Helen Cockburn, author
Winfred Milton Grandy: A Philatelic Biography (CD-ROM),
Joseph P. Connolly and Sean P. Connolly
Tips on Types Second Edition, Robbin Dick, author
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Indo-China Revenue Stamp Catalog, second edition, Society of
Indo-China Philatelists
United States Post Offices Volumes 1–8, La Posta Publications,
Richard W. Helbock, author
Soviet Occupation of Poland, 1939–1941: A Postal History, third
edition, Chris Kulpinksi, author
Collection of Articles Originally Published in “EFO Collector”,
Joseph Monteiro, author
Levy’s Boy and Girl Scout Cachet Covers of the United States,
Volumes I and II: 1910–1960 second edition, Scouts on
Stamps Society International, Jay L. Rogers, author

Silver

Postal Cards and Aerogrammes of the Vatican City State, Albert
A. Antonellis, author
Postal History of the Powell Bros. Livestock Emporium, Halifax
Trading, Ltd., Norman A. Cohen, author
Watercraft on Stamps II, ATA, Katherine A. Kirk, author
Stamps of the Polar Worlds, Frank R. Michel, author
Handbook of Perforated or Punched Initials, Numbers, and/
or Designs in U.S. Revenues, Arthur J. Mongan, editor; also
awarded the State Revenue Society gold medal
The W. G. MacFarlane Picture Postcard Handbook, 1902–1910,
Michael J. Smith, author

Periodicals
Gold

American Revenuer Volume 61, American Revenue Association
Kenneth Trettin, editor
Penny Post Volume 15, Carriers and Locals Society, Larry
Lyons, editor
Rossica 2007, Rossica Society of Russian Philately, Jeff
Radcliffe, editor
Texas Philatelist Volume 55, Texas Philatelic Association,
Douglas Moss, editor

Vermeil

British Caribbean Philatelic Journal Volume 48, British
Caribbean Philatelic Study Group, Everett Parker, editor
Czechoslovak Specialist Volume 69, Society for Czechoslovak
Philately, Ludvik Z. Svoboda, editor
First Days Volume 52, American First Day Cover Society,
Richard L. Sine, editor

Silver

Graebner Gazette Volume 7, Robert C. Graebner Chapter #17
AFDCS, Rollin F. Berger, Jr., editor
Speleophilately Nos. 79–81, Speleophilately International, Jan
Paul van der Pas, editor

Silver-Bronze

Greater Richmond Stamp Club newsletter, Juanita Cerillo, editor

✒

Secretary–Treasurer’s

Report

August 1, 2008

W

State of Our
Membership

riters Unit #30 continues efforts to expand its membership
base. I mailed dues notices on December 30, 2007, and all
but 12 have paid their dues. Seven have paid for multiple years —
four through 2009, two through 2010, and one through 2011.
Membership now stands at 229 with 12 in Canada, one in
Mexico, and nine overseas. Unfortunately we have not offset the
12 members we dropped for non-payment of dues and the four
who have died. Only nine new members have been recruited
since January 1.
The editor and I suggest that members continue their recruitment efforts for new members — “every member find a member.”
We commenced 2008 with a balance of $6,760 and have since
added $3,490 in membership dues plus $95 contributions made
by six members. Printing and mailing four issues of The Philatelic
Communicator during the past 12 months have averaged $796
per issue, up from $758 per issue for the preceding 12 months
due to the increase of postage rates. If the postage rates continue
to rise, it will be necessary to increase the membership dues.
Since odd-numbered years are WU #30 election years, we will
publish a Call for Nominations in the First Quarter 2009 issue of
The Philatelic Communicator and the ballot will be published in
the Second Quarter 2009 issue. Alan Warren is chairman of the
Nominating Conmittee.

Change of Address

0228 Daniel C. Warren, 1512 Steuben Road, Gloucester Point,
VA 23062-2009

Reinstated

1922 Ronald H. Hill, 7590 West Caley Drive, Littleton, CO
80123-3016

Deceased

Joan Helen Griffenhagen, the wife of the secretary–treasurer, died
on June 23. Her death came a full year after her diagnosis of cancer, and two days before the 62nd anniversary of their wedding. A
complete obituary is on page 4 of this issue.

WU #30 Board Meeting

The Writers Unit #30 Board will meet at 10 a.m. on August 17 during StampShow 2008. Details in the president’s column on page 3.

About Writers Unit #30

The purpose of the Writers Unit #30 of the APS is to encourage
and assist philatelic communication, knowledge, and comradeship.
Membership is open to any philatelic writer, columnist, editor, or
publisher — and anyone interested in philatelic communication.

Join Us Today

Join Writers Unit #30 now and begin reaping the benefits of
membership, including your subscription to The Philatelic
Communicator. Applications received before October 1 will
be recorded as members for that calendar year and these members will receive all issues of The Philatelic Communicator
for the calendar year.
Applications received on or after October 1 will be recorded as
members for the following calendar year.
An application may be downloaded at www.wu30.org.

Membership Dues

USPS ZIP Code Addresses............................................ $15.00
Canada and Mexico...................................................... $17.50
All Other Addresses...................................................... $20.00
Payment must be made in U.S. funds by a check imprinted
with a U.S. bank transit number, or by postal money order, payable to APS Writers Unit #30. Some overseas members prefer to
send U.S. bank notes by certified mail.

Updating Your Mailing Address

Please notify us of address changes to assure that you receive each
issue of The Philatelic Communicator without delay. This will
also save WU #30 more than $1.00 because the USPS charges 70
cents when they have to send us an address correction, and we still
have to pay the postage for reshipping the issue to the member.
George B. Griffenhagen, WU #30 Secretary-Treasurer
2501 Drexel St., Vienna, VA 22180-6906

Philatelic Communicator Advertising Rate Card
We can accept camera-ready copy or create an ad for you.
Full Page — $80 • 7.33 × 10 inches; 44 × 60 picas
Half Page — $55 • Vertical 3.6 × 9.5 inches; 21p6 × 57 picas;
Horizontal 7.33 × 4.7 inches, 44 × 28p6 picas
Quarter Page — $35 • 3.6 × 4.6 inches, 21p6 × 28p6 picas
Deadlines January 15, April 15, July 15, October 15
Contact the editor at 813-962-7964; e-mail astarkweather@wu30.org

Writers Unit #30, APS
George B. Griffenhagen
2501 Drexel Street
Vienna, VA 22180-6906
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